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arem¢Ãc	a	rasu	oA	)SOi(	ralulec	arap	moorthgiL	od	o£Ãsrev	atsen	ovoN	​Ã	ovitacilpa	on	arem¢Ãc	an	etrocer	ed	osruceR	Clarity,	Brightness	and	others.	Lightroom	CC	2015/Lightroom	6	Â	Â	New	in	this	version	of	Lightroom	now	provides	a	new	preference	that	allows	you	to	use	the	processing	unit	(GPU).	Sign	up	for	an	Adobe	ID	and	get	a	time-limited
test	that	lets	you	sync	photos	and	edits	µ	all	devices,	access	Lightroom	on	the	desktop	and	on	the	web,	Access	Photoshop	CC,	and	more.	Here	are	the	broad	steps	to	import	photos:	click	File>	Import	photos	and	videos.	Click	+	in	the	µ	pane,	and	then	enable	the	display	collection	filter.	Therefore,	it	takes	some	time	for	your	HDR.	image	to	appear	in	the
Lightroom	photo	view	or	the	display	grid	after	capturing	the	shot.	The	Lightroom	import	interface	for	mobile	now	displays	the	thumbnails	of	all	the	images	of	the	plug	in	the	camera.	Exit	the	import	interface	Here	are	the	large	steps	to	import	photos	from	a	connected	camera:	Connect	your	Android	³	device	with	the	DSLR	Camera	using	a	supported
USB	OTG	cable.	Reset	all	settings	µ	in	Pro	mode	Manually	control	shutter	speed,	ISO	and	focus	distance	in	Pro	mode.	In	the	notification	bar	for	your	Android	device,	Lightroom	for	Mobile	displays	import	µ	on	progress	and	completion	status.	You	can	also	provide	a	star	rating	and	tag	photos	on	this	panel.	Support	for	new	cameras	and	improved	lenses
in	this	version	of	Lightroom	for	a	complete	list	of	supported	cameras	and	lens	profiles,	see	these	features:	Camera	Models	Supported	Lens	Profile	Problems	fixed	in	this	version	of	Lightroom	Lightroom	for	mobile	|	iOS	2.8	|	July	2017	This	version	of	Lightroom	for	Mobile	IOS	launches	the	following	new	features	and	enhancements	for	iPhone	and	iPad.
A	classification	overlay	appears	showing	the	current	classification	as	you	flick.	Mobile	Lightroom	|	Android	2.3.3	|	April	2017	This	version	of	Lightroom	for	Mobile	Android	features	support	for	Samsung	DEX	on	Samsung-compatible	³	devices.	the	attributes	of	the	image	in	deliveries	that	you	want	to	use	together	in	a	layout	or	presentation.	When
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supports	HDR	capture	mode	on	any	iPhone	or	iPad	device	that	has	at	least	one	12-megapixel	camera	running	on	iOS	10.0	or	later.	For	details,	see	Working	with	Lightroom	for	Mobile	(iOS)	|	Capture.	In	the	library	or	develop	modules,	select	the	images	and	choose	Photo>	Photo	Merge>	HDR.	Enjoy	the	bright	visual	experience	of	iPad	Pro	by	adjusting
color,	tone	or	brightness	in	your	photos.	Bright	and	perforated	light	faded	Vintage	Hot	Cyan	B	&	W	faded	B	&	W	to	learn	more	about	predefinations,	see	the	predefinations.	(Mac	Only)	Support	to	place	photos	as	intelligent	objects	linked	in	Photoshop	CC	by	opposition	+	dragging	them	from	the	library	grid	to	Photoshop.	The	New	Red	Eye	Correction
Tool	Icon	in	this	Lightroom	version,	you	can	modify	Graduated	Filter	and	Radial	Filter	Makers	using	Brush	Controls.	Selecting	the	Automatic	Harvest	When	the	boundary	warn	slider	is	30	for	more	information,	see	Create	Panoramas.	For	details,	see	Keyboard	shortcuts.	Raw	badge	in	the	miniature	indicating	a	raw	photo	D.	In	addition,	the	Information
Panel	displays	the	metadata	associated	with	your	photo.	You	can	choose	to	navigate	although	the	thumbnails	based	on	two	views:	time	visualization.	When	you	connect	your	phone	to	Dex	Station,	any	editions	you	did	in	the	Lightroom	for	Mobile	App	before	connecting	your	phone	to	be	saved	automatically.	New	in	this	Lightroom	Version	for	Mobile	for
Mobile	(Android)	New	Import	Interface	This	version	presents	a	new	user	interface	when	adding	/	Import	photos	from	the	scroll	roll	from	your	mobile	device	or	from	the	gallery	at	Lightroom.	Self	tones	the	image	to	give	you	a	uniformly	toned	mixed	HDR	image.	Cultivation	rate	options	-	D.	as	an	enhancement	in	this	version,	this	new	Icon	dedicated	to	a
ralulec	ralulec	arap	moorthgiL	od	o£Ãsrev	atsen	odaromirpa	ajes	ovitisopsid	o	euq	ridepmi	arap	o£Ã§Ãarugifnoc	avon	A	.aviturtsed	o£Ãn	©Ã	otof	an	adacilpa	atiehloc	a	,arutluc	ed	axat	ed	o£Ã§Ãisoperbos	reuqlauq	me	rarita	ªÃcov	odnauQ	.soded	sªÃrt	ed	etepat	ed	otseg	o	iutitsbus	setna	Activation	of	the	new	sleep	prevention	configuration	prevents
your	device	from	sleeping	while	connected	to	a	power	source.	For	details	on	other	configurations	in	Lightroom	for	mobile	devices,	see	Sidebar	of	the	Lightroom	application.	However,	these	features	are	available	on	your	device	only	if	the	support	has	been	activated	/	defined	by	the	device	manufacturer.	Lightroom	automatically	detects	folders	on	your
zone-containing	photos,	any	connected	camera	or	camera	card	and	any	available	catallog	of	Photoshop	Elements	on	your	computer.	Apply	one	of	the	five	new	predefined	predefits	specially	formulated	when	capturing	a	photo	of	the	Adobe	application	camera.	Simplified	iPhone	Edition	Interface	with	New	Professional	Level	Control	Information	Panel	in
the	Loupe	iPhone	and	iPad	Capture	Interface	Redesigned	Support	for	New	Câms	and	Lens	Bugs	and	Performance	Improvements	Ediã	Interface	Simplified	with	new	professional	level	control	in	this	Lightroom	version	for	Mobile	iOS	(iPhone	only)	Edit	Panel	adjust	the	tonal	scale	with	tone	controls	in	the	Menu	Light	menu	on	Lightroom	for	iOS	(iPhone)
mobile	devices	The	new	experience	in	Lightroom	for	mobile	devices	on	your	iPhone,	when	opening	a	photo	in	the	Loupe	view,	you	can	choose	to	work	on	the	following	panel.	When	you	select	Automatic	Cutout,	gross	camera	cuts	the	visible	transparency	areas	in	the	current	value	of	the	contour	fold	configuration.	View	the	metadata	associated	with
your	photo.	Enhanced	user	interface	designed	specifically	for	iPad.	When	capturing	photos,	you	can	make	adjustments	in	real	time	on	the	scene.	The	novelty	in	this	Lightroom	version	import	video	and	synchronizes	them	with	web	/	desktop	adjustments:	Tom	curve,	color	mix	and	vignettes	copy	and	paste:	Edit	images	faster	by	copying	image	settings
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sotnemivom	reuqsiauq	arap	imported.	Determine	the	consistency	of	the	white	balance	in	the	photos.	New	New	Iphone	Selecting	tool	to	selectively	apply	exposition,	brightness,	clarity	and	other	settings	to	a	specific	part	of	a	photo.	Lightroom	on	iOS	now	features	a	high-level	collection	called	Lightroom	photos	that	displays	all	your	photos	organized	by
timeline.	The	Lightroom	for	Mobile	automatically	applies	the	camera's	profile	to	your	photos	based	on	the	image	metadata.	Tom	curve	mode	â	€	Â.	In	the	notification	bar	of	your	Android	device,	tap	the	USB	connection	notification	that	appears	after	connecting	your	camera.	Copyright.	Lightroom	notifications	appear	in	the	lower	right	corner	of	the
user	interface	on	the	connected	monitor.	View	these	features:	CÃ	¢	mere	templates	supported	Lens	Lens	Profiles	Lightroom	CC	2015.4	/	Lightroom	6.4	Limit	distortion	When	viewing	panoramas	ã,	this	feature	is	available	only	in	Lightroom	CC.	New	in	this	Lightroom	version	for	Android	Mobile	Lightroom	application	layout	for	Android	Mobile	was
optimized	for	a	large	screen	viewing	experience	to	support	the	Samsung	Dex.	Support	for	new	cases	and	lenses.	3D	touch	support	for	sensitive	application	to	enhancements	on	devices	that	support	3D	touch.	Merge	the	Multiple	Exposure	images	to	create	a	32-bit	floating-point	DNG	file	â	€	œ	"your	raw	raw	HDR	image.	Lightroom	CC	2015.5	/
Lightroom	6.5	Support	for	new	cans	and	enhanced	lenses	In	this	Lightroom	CC	2015.5	/	6.5	/	6.5	support	deploys	support	for	new	cans	and	lens	profiles.	Now	you	can	view	slide	presentations	in	the	ratio	rate	of	the	screen	or	in	the	desired	exit	ratio	(16x9	or	4x3).	Button	Capture	I.	For	example,	adjust	the	white	balance,	display	and	contrast	from	the
photo	on	the	Basic	Mode	Panel.	General	Improvements	of	Stability.	With	the	new	Pro	mode,	your	iPhone	and	Lightroom	now	is	your	DSLR	camera.	After	switching	to	the	For	touch	work,	you	don't	have	access	to	the	controls	available	in	Lightroom	for	mobile	and	more.	In	Light,	Color,	Color,	The	effects	edit	menus,	user	interface	³	for	Curve,	HSL
(renamed	MIX),	and	Split	Tone	have	been	updated.	For	additional	details,	see	Edit	photos.	For	a	complete	list	of	supported	cameras,	lenses,	and	lens	profiles,	refer	to	these	features:	Supported	Camera	Models	Supported	Lens	Profiles	Problems	fixed	in	this	version	of	Lightroom	Fixed	the	compatibility	warning	of	the	incorrect	Camera	Raw	plug-in
displayed	in	Lightroom	when	you	are	not​	​Edit	in	Photoshop'.	and	other	settings	for	a	specific	part	of	a	photo.	Now	you	can't	apply	lens	µ	to	all	photos	or	just	raw	pictures	during	import	by	turning	on	the	import	setting	in	the	sidebar.	In	the	Develop	section,	select	Use	Smart	µViewing	instead	of	Image	Editing	Originals.	The	Panorama	Merge	Preview
dialog	box	now	features	a	Boundary	Warp	(0-100)	slider	configuration.	Click	OK	and	restart	Lightroom.	µ	Lightroom	now	offers	a	unified	experience	that	lets	you	import	photos	from	your	computer,	digital	cameras,	³	cards	and	more.	New	in	this	version	of	Lightroom	for	Apple	TV	Pass	along	the	right	edge	of	the	touch	surface	of	the	Apple	TV	remote
control	to	quickly	scroll	through	your	Lightroom	photos	and	videos.	In	the	Develop	³,	click	the	Red-Eye	Running	tool	icon.	By	default,	Lightroom	Photo	Paste	is	selected.	If	you	don't	have	a	Photoshop	Elements	cat	on	your	computer,	you	can	also	import	it	quickly	into	Lightroom.	Rate	and	tag	your	photo.	Directly	access	photos	from	your	Camera	Roll.	G.
New	in	this	version	of	Lightroom	Lightroom	allows	you	to	not	easily	merge	photos	from	a	landscape	into	a	panorama	of	taking	the	heat.	Choose	DNG	to	take	pictures	in	the	raw	format	Digital	Negative	(DNG).	Publish	and	view	in	their	photos	that	are	part	of	a	shared	collection.	Click	Pet	Eye	and	drag	from	the	center	of	the	eye	to	select	the	pupil.	New
Show	Featured	Featured	Feature	in	the	application’s	camera	that	shows	overexposed	areas	before	capture.	For	example,	you	may	want	to	lighten	a	face	to	make	it	stand	out	in	a	portrait.	You	can	set	a	timer	to	capture	photos	automatically	or	capture	photos	in	fast	mode.	Support	3D	touch	on	iPhone	6S/6S	Plus.	Available	only	for	Creative	Cloud
Members	local	settings	allow	you	to	selectively	apply	exposure,	brightness,	clarity,	and	other	adjustments	to	a	specific	part	of	a	photo.	(Android)	which	starts	with	version	2.3,	Lightroom	for	mobile	(Androom)	supports	HDR	mode	only	on	Samsung	S7,	Samsung	S7	Edge,	Google	Pixel	and	Google	Pixel	XL	mobile	devices.	After	your	trial	has	expired,	you
will	continue	your	access	to	all	the	editing	features	for	free	on	your	smartphone	or	tablet.	Lightroom	for	Mobile	(Android)	now	features	a	new	pro	mode	that	provides	more	control	over	the	camera	in	the	app.	As	you	move	the	slider	to	the	right,	Lightroom	reduces	the	amount	of	fog	or	fog	visible	in	the	photo.	Now	you	can	import	photos	directly
(including	RAW	images)	from	a	connected	camera	in	Lightroom	for	mobile.	Displays	image	thumbnails	segmented	based	on	the	folder	structure	on	your	mobile	device.	View	these	resources:	Supported	Camera	Models	Lens	Profile	Issues	Fixed	in	this	Version	of	Lightroom	Lightroom	for	Mobile	|	iOS	2.7.3	|	April	2017	This	version	of	Lightroom	for
mobile	iOS	releases	support	for	new	cameras	and	lenses,	bug	fixes,	and	performance	improvements.	(Left)	Classification	of	a	photo.	H.	CMYK	exposure	lock	bracket	while	soft-proof.	In	the	camera	module,	tap	the	capture	file	format	(DNG,	by	default)	badge	at	the	top	of	the	viewfinder	to	switch	between	the	JPEG	and	DNG	capture	options.
Compatibility	fixes	for	MacOS	Sierra	compatibility	settings	have	been	made	in	this	Lightroom	login,	so	you	will	need	to	run	smoothly	when	you	do	not	upgrade	to	MacOS	Sierra.	See	this	technology	note	for	more	details.	Adjust	shades.	hues.	Color	/	B	&	W	mode	Using	the	pen	S	to	set	a	particular	hue	while	working	in	Color	/	B	&	W	mode,	press	the	S
Pen	button	and	hover	over	any	tint	to	select	it.	Now	you	can	save	the	lightroom	for	mobile	photos	(Android)	in	your	device	gallery	in	your	native	resolution	on	the	highest	quality	available.	In	the	library's	module,	change	to	people's	viewing	and	choose	to	find	faces	in	your	catalog.	Lightroom	6.14	|	December	2017	Lightroom	6	was	discontinued	and	it
is	no	longer	available	for	purchase	at	Adobe.com.	Tap	Add	to	at	the	bottom	of	the	screen.	The	divided	vision	of	iOS	9	and	slide	on	multitasking	improvements	make	Lightroom	for	Mobile	&	iPad	for	the	best	combination	for	moving	photographer.	Settings	for	a	filter	brush	Improvement	in	this	Lightroom	version,	you	can	now	adjust	the	amount	of
panoramic	and	zoom	using	a	convenient	slider.	2015.x	/	6.x	Lightroom	CC	&	Lightroom	releases	for	October	2017	and	later	Lightroom	Classic	releases	are	now	available!	See	New	Resources	Summary.	Lightroom's	2015.x	/	6.x	releases	launch	several	new	features	and	enhancements	that	enrich	your	digital	image	experience.	Mobile	lightroom	|
Android	2.3.4	|	May	2017	This	Lightroom	for	Mobile	Android	launches	HDR	support	in	Samsung	S8	and	S8	+	mobile	devices,	support	for	new	cases	and	lenses,	and	bug	fixes	and	performance	improvements.	A	new	size	of	-visualization	called	auto	is	available.	For	more	information,	see	Merge	Photo	HDR.	New	redesigned	capture	interface	in	this
Lightroom	version	for	iOS	mobile	(iPhone	and	iPad)	The	redesigned	capture	interface	now	allows	you	to	capture	photos	in	two	modes	-	Auto	and	Pro.	You	can	also	specify	a	layout	projection.	Ã	¢	â	€	"or	let	Lightroom	choose	the	appropriate	projection	automatically.	After	the	impairment	conclusion,	you	can	clear	the	notification	bar	notification.	Apply
lens	corrections,	lens,	Profile	Corrections	and	Copyright	ã,	New	In	this	Lightroom	for	Mobile	(Android)	Lightroom	for	Mobile	(Android)	now	allows	you	to	apply	lens	profile	corrections,	CÃ	¢	mere	profile	corrections	and	copyright	metadata	in	your	photos.	Lens	corrections.	Lightroom	suggests	names	for	similar	photos.	You	can	also	use	the	keyboard
shortcuts	supported	by	the	mobile	lightroom.	Set	ISO	O.	When	you	apply	100%	zoom	(1:	1	mode)	in	the	module	to	develop,	the	Lightroom	switches	to	originals	even	if	the	preference	to	use	intelligent	views	instead	of	originals	for	image	edition	is	enabled.	Best	export	photos	in	complete	resolution.	You	can	customize	several	configurations	for	these
brinces.	Now	take	color	control	to	the	next	level	with	a	complete	function	curve	tool,	allowing	access	to	RGB	as	well	as	red,	green	and	blue	color	channels	in	your	photo.	Shooting	predefinations	are	available	only	for	64-bit	devices	such	as	iPhone	5S	and	posterior	and	iPad	Air	and	later.	An	option	to	allow	you	to	do	this	is	available	in	effects	on	copying,
synchronizing	and	new	predefined	dialogues.	Lightroom	for	Apple	TV	1.0	|	July	2016	You	can	now	install	Lightroom	for	Apple	TV	in	your	Apple	TV	(4th	generation)	to	view	your	photos	and	lightroom	collections	loaded	in	the	cloud	and	enjoy	slide	presentations	on	your	TV.	You	can	go	through	your	collections	to	quickly	find	the	photo	you	are	looking	for
or	expand	in	200%	in	your	photos	to	view	all	the	details	on	the	big	screen.	If	you	make	changes	to	your	photos	or	collections	on	the	Lightroom	Desktop,	Lightroom	for	Mobile	or	Lightroom	on	the	Web	while	the	Lightroom	application	for	Apple	TV	is	running,	you	can	synchronize	the	latest	editions	Using	the	option	to	recharge	collections	in
configurations.	Iphone	7	and	iPhone	7	Holder	Optimized	for	iPhone	7	Support	for	iPhone	7	Plus	Dual	Lens	Camera	Improved	color,	lens	and	street	profiles	for	iPhone	7	and	7	Plus	DNG	files	Bug	µ	and	performance	improvements	Lightroom	CC	2015.7/Lightroom	6.7	6.7	,	Gnizinagro	ylkciuq	uoy	teg,	erom	dna,	troppus	erutseg	devorpmi,	retsaf	sotohp
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this	version	of	Lightroom	Lightroom	CC	2015.2/Lightroom	6.2	New	unified	import	experience	in	this	version	of	Lightroom	This	feature	has	been	discontinued	in	Lightroom	CC	2015.3/Lightroom	6.3	and	is	no	longer	available.	See	Use	the	Adaptive	Wide	Angle	filter	in	Photoshop	Help.	This	new	interface	displays	the	thumbnails	of	all	the	images	stored
on	your	³	device.	Capture	Mode	Switch	(Auto/Pro)	J.	New	camera	and	lens	support	Enhanced	in	this	version	of	Lightroom	for	³	(Android)	devices	For	a	complete	list	of	supported	cameras	and	lens	profiles,	see	these	features:	Supported	camera	models	Supported	lens	profiles	General	stability	improvements.	You	cannot	change	the	proposal	of	your
photo	later	when	you	edit	it.	Apple	Pencil	support	for	sensitive	improvements		press.	New	in	this	version	of	Lightroom	Working	in	the	same	way	as	the	red-eyed	run,	the	eye	rush	of	esteemed	animals	in	Lightroom	helps	to	cure	the	unnatural	colors	of	the	eyes	of	esteemed	animals	captured	in	the	photos.	When	viewing	the	panorama,	you	cannot	choose
to	Auto-crop	the	merged	image	to	remove	unwanted	areas	of	transparency.	The	generated	raw	HDR.	files	are	large	and	require	a	lot	of	background	processing,	as	explained	above.	In	the	Library	or	Develop	³,	select	the	source	images	and	choose	Photo	>	Merge	Photo	>	Panorama.	When	using	the	Camera	in	the	application,	you	can	now	point	your
Camera	to	a	neutral	color	(no	color)	surface	in	the	scene	and	block	the	white	balance.	&	Nbsp;	Automatically	sync	slides	for	Music	Set	and	lock	exposure	compensation.	For	more	information	µes,	see	Apply	local	adjustments.	Configure	Q	Exposure	Compensation.	This	wide	range	color	space	seroc	seroc	sa	o£Ãsicerp	moc	matilfer	moorthgiL	on	satief
seµÃ§Ãide	sa	sadot	euq	odnitnarag	,BGRs	seroc	ed	o§Ãapse	o	euq	od	seroc	siam	%	52	Photos.	View	how	predefinations	will	be	applied	to	your	photo	before	capturing	and	enjoying	the	freedom	to	adjust	the	configurations	after	capturing	with	complete	non-destructive	features.	Rate	a	photo	to	quickly	evaluate	a	photo	on	the	rate	and	revision	panel,
now	you	can	back	up	or	down	half	the	screen	on	the	left.	After	adding	a	mask,	to	access	brush	controls,	select	the	Brush	option	next	to	New	/	Edit.	To	access	these	new	noise	reductions	and	affiance	controls:	(iPhone)	on	the	edition	panel	in	the	magnifying	glass	view,	touch	Details	icon	at	the	bottom	of	the	screen.	(Left)	Capture	interface	options	in
HDR	mode	on	iPhone.	Download	on	the	Import	Interface,	select	Photos	that	you	want	to	import	to	the	Lightroom	to	Mobile.TAP	Add	photos	at	the	bottom	of	the	screen.	On	the	Lightroom	Import	screen	that	appears,	choose	a	collection	of	your	existing	Lightroom	collections	in	which	you	want	to	import	the	selected	photos	or	create	a	new	collection.
When	you	resize	the	Lightroom	application	window	on	the	connected	monitor,	the	contents	scale	and	thumbnails	of	the	application	accordingly.	Adjust	the	Deha	slider!	A	correction	for	a	bug	that	caused	a	failure	for	some	users	when	relaunching	the	Lightroom	for	the	mobile	application.	For	more	information,	see	Create	Panoramas.	Corrections	of	CÃ
¢	mere	profile.	You	can	also	add	your	copyright	metadata	to	photos	while	importing	to	the	lightroom	for	the	mobile	application,	allowing	the	import	configuration	of	the	sidebar.	The	mask	overlays	for	gradient	and	radial	filters	are	now	accessible	using	the	same	menu	commands	and	keyboard	shortcuts	that	display	the	mask	overlapping	for	the	local
setting	brush.	New	keyboard	shortcut	to	cycle	through	vertical	modes:	control	control	+	/	ctrl	+.	Add	selected	photos	e.g.	you	can	reposition	the	adjustment	brush	strokes	by	selecting	and	dragging	the	edition	pins.	Set	shutter	speed	p.	You	can	switch	to	the	touch	workspace	from	anywhere	in	the	app	by	clicking	on	the	touch	icon	available	only	on
touch-enabled	devices	such	as	the	Surface	Pro	3.	This	visualization	is	©	Ãºtil	when	you	want	to	edit	a	photo	to	make	it	look	like	a	different	reference	photo.	When	viewing	your	photo	in	Loupe	preview,	you	can	use	mouse	scroll	to	zoom	in	and	out.	In	Lightroom	for	mobile	(Android),	you	can	now	set	the	desired	exposure	level	for	your	photos	by	simply
swiping	the	camera	viewfinder	screen	in	the	app.	Support	for	iPad	Pro.	New	support	P3	wide	range	color	spacing	AlÃ	©	m	to	support	DNG	format,	Lightroom	for	iOS	2.5	mÃ³vel	also	©	m	adds	support	for	the	new	wide-range	P3	color	spacing	found	on	iPad	Pro	9.7	and	iPhone	7	and	7	Plus.	Enhanced	in	this	release	of	Lightroom	CC	2015.8/6.8
implements	support	for	new	cameras	and	lens	profiles.	Local	settings:	White	and	black	sliders	are	available	only	in	Lightroom	CC	2015.1.	Local	adjustment	controls	in	Lightroom	now	include	white	and	black	sliders.	Tap	Add	Photos	in	any	preview	now	starts	the	new	import	interface	in	Lightroom	for	mobile	(Android).	Guided	up	to	correct	distorted
perspective	in	photos	is	new	in	this	version	of	Lightroom	is	only	available	in	Lightroom	CC.	Overall	stability	improvements.	Any	edit	made	on	the	images	will	remain	local	on	the	device	until	©	that	you	come	in.	Take	a	look	at	the	new	user	interface,	which	was	the	beginning!	The	new	Lightroom	for	mobile	(Android)	user	interface	For	detailed
information	on	the	new	editing	experience,	see	Edit	photos.	For	more	information,	see	Face	Recognition.	Choose	the	source	from	which	you	want	to	import	photos.	For	more	information,	see	Work	with	Lightroom	on	mobile.	Video	playback	support	New	in	this	release	of	Lightroom	for	Apple	TV	Lightroom	for	Apple	TV	Lightroom	for	Apple	TV	,4.3.2
,4.3.2	moc	odna§ÃemoC	lev³Ãm	diordnA	arap	moorthgiL	od	o£Ãsrev	atsen	ovoN	​Ã	siev³Ãm	sovitisopsid	+8S	gnusmaS	e	8S	gnusmaS	me	RDH	arap	etropuS	.moorthgiL	od	sodazinorcnis	soed​Ãv	sues	azudorper	ªÃcov	euq	etimrep	For	mobile	(Android)	now	supports	HDR	mode	in	Samsung	S8	and	Samsung	S8	+	mobile	devices.	All	photos	New
synchronized	photos	in	this	Lightroom	version	in	the	library	module,	the	new	synchronized	photo	collection	in	the	Catallog	Panel	displays	all	photos	of	the	Lightroom	(including	those	that	are	not	part	of	any	Collection)	that	are	synchronized	with	Lightroom	mobile	customers.	Support	for	new	cans	and	enhanced	lenses	in	this	Lightroom	Latch	for
Android	Mobile	for	a	complete	list	of	supported	cans	and	lens	profiles,	see	these	features:	Lens	Supported	Lens	Lens	Supported	Lightroom	CC	2015.10	Lightroom	6.10	Support	for	new	cans	and	reinforced	lenses	This	Lightroom	Lightroom	CC	2015.10	/	Lightroom	6.10	support	for	new	cans	and	lens	profiles.	Release	your	creativity	with	free	access	to
all	Lightroom	Capabilities	as	long	as	you	want	on	your	smartphone	or	tablet.	The	vertical	guided	tool	in	the	new	transformation	panel	allows	you	to	elaborate	to	four	guides	(line	segments)	directly	in	the	photo	to	indicate	the	image	features	to	be	aligned	with	horizontal	or	vertical	axis.	As	you	draw	the	guides,	the	photo	is	transformed	interactively.
The	Capture	Option	DNG	/	JPEG	L.	Lightroom	checks	your	image	catalog	to	find	potential	faces	for	your	review	and	confirmation.	Improvements	for	web	module	Improvement	in	this	Lightroom	version,	but	from	the	classical	HTML	gallery,	three	new	gallery	styles	are	now	available:	these	galleries	are	designed	to	work	with	web	browsers	¢	For
desktop	and	mobile.	After	you	set	the	exposure	level,	you	can	block	the	exposure	compensation	to	your	current	value	by	tapping	the	icon	()	in	the	lower	right	corner	of	the	capture	interface.	Shot-through	predefinations.	If	you	are	running	the	Lightroom	on	Mac	OS	X,	you	can	use	the	GPU	Mac	OS	X	version	10.9	or	posterior.Ã	¢	New	in	this	Lightroom
Lightroom	version	allows	you	to	quickly	organize	and	find	images	using	facial	facials	.ehlocse	ªÃcov	euq	medro	an	etnemlaicneuqes	sadizudorper	o£Ãs	saxiaf	sA	.sedils	ed	seµÃ§Ãatneserpa	arap	acisºÃm	ed	saxiaf	01	©Ãta	ranoicida	edop	ªÃcov	arogA	mooz	e	nap	ed	etnazilsed	elortnoc	o	arap	aicnªÃreferP	.sairohlem	e	sosrucer	sovon	setniuges	so
a§Ãnal	VT	elppA	rof	moorthgiL	od	o£Ãsrev	atsE	7102	ed	otsogA	|	1.1	VT	elppA	arap	moorthgiL	)7102	ed	orbutuo(	31.6	moorthgiL	me	sadaxif	setnel	ed	sifrep	ed	seµÃtseuQ	sodatropus	arem¢Ãc	ed	soledoM	:sosrucer	setse	etlusnoc	,etnel	ed	sifrep	e	sadatropus	sarem¢Ãc	ed	atelpmoc	atsil	amu	arap	moorthgiL	od	o£Ãsrev	atsen	sada§Ãrofer	setnel	e
sarem¢Ãc	savon	arap	etropuS	|	31.6	moorthgiL	)7102	ed	orbmezed(	41.6	moorthgiL	me	sodaxif	etnel	ed	sifrep	ed	samelborP	sodatropus	arem¢Ãc	ed	soledoM	:sosrucer	setse	etlusnoc	,etnel	ed	sifrep	e	sadatropus	sarem¢Ãc	ed	atelpmoc	atsil	amu	arap	moorthgiL	od	o£Ãsrev	atsen	sada§Ãrofer	setnel	e	sarem¢Ãc	savon	arap	etropuS	.seµÃzar	setnerefid
me	raritA	.SOi	ovitisopsid	ues	on	GND	WAR	snegami	ed	arutpac	a	atropus	arogA	)SOi(	eliboM	arap	moorthgiL	erutpaC	egamI	WAR	arap	etropuS	.amaronap	ed	megalcsem	ed	o£Ã§Ãarepo	amu	raicini	arap	od​Ãubirtaer	iof	)M	+	lortnoC	/	+	lrtC(	liam-e	ed	otof	ed	odalcet	ed	ohlata	O	.01	SOi	on	o£Ã§Ãucexe	me	SOi	sovitisopsid	sesse	a	odatimil	©Ã	)SOi(
eliboM	rof	moorthgiL	ebodA	olep	odicenrof	WAR	snegami	rarutpac	arap	etropus	o	,otnatroP	.sovitisopsid	ed	satsap	ed	o£Ã§ÃazilausiV	.aifargotof	amu	me	orieoven	uo	anilben	ed	edaditnauq	a	etnemua	uo	etnemlicaf	aunimid	ªÃcov	euq	etimrep	moorthgiL	O	.1.5102	CC	moorthgiL	on	sanepa	lev​Ãnopsid	¡Ãtse	osrucer	essE	​Ã	1.6	moorthgiL	/	1.5102	CC
moorthgiL	moorthgiL	od	o£Ãsrev	atsen	odavirp	ni-gulP	ecivreS	hsilbuP	ecnaheB	.	potkseD	moorthgiL	on	sadazinorcnis	sadot	saifargotof	ed	o£Ã§Ãeloc	a	euq	somsem	so	o£Ãs	)diordnA(	ralulec	arap	moorthgiL	on	moorthgiL	od	sotof	ed	o£Ã§Ãazilausiv	e	,)SOi(	ralulec	arap	moorthgiL	me	atsiV	moorthgiL	,beW	an	moorthgiL	on	sotof	sa	sadot	ed
o£Ã§Ãazilausiv	an	mecerapa	euq	sotof	sa	,otnatroP	.aigoloncet	With	version	2.1,	Lightroom	for	mobile	support	manually	controls	shutter	speed,	ISO	and	focus	distance	on	devices	running	versions	of	Android	5.0	(lollipop)	and	later.	later.	photo	selected	from	the	Camera	Roll	now	opens	in	Camera	Roll	edit	view	where	you	can	apply	Crop,	Presets,	and
Adjustments.	(Right)	Processed	raw	HDR	image	in	the	Loupe	view	When	you	trigger	the	capture	button	in	the	new	High	Dynamic	Range	(HDR)	mode	to	capture	a	high-contrast	scene,	Lightroom	for	mobile	automatically	does	all	the	processing	in	the	background	to	create	a	raw	HDR	image:	Lightroom	mobile	analyzes	your	scene	to	determine	the
appropriate	spread	of	exposure	values	to	capture	multiple	exposure-bracketed	images.	This	allows	you	to	preview	your	photo	at	the	desired	crop	ratio	even	before	you	capture	it.	The	Copy	to	Lightroom	dialog	displays	the	progress	and	notifies	you	when	the	copying	process	is	complete.	​Ã	Â	Cycle	through	your	collection	to	quickly	rate	and	flag	your
photos.	Switch	to	the	Effects	panel	of	the	Develop	module.	iPhone	6	DNG	profile	is	not	supported	in	the	current	version	of	Lightroom	desktop​Ã	Â(Lightroom	CC	2015.6/Lightroom	6.6).	Cure	pet	eye	effect	in	photos.	If	necessary,	choose	the	photos	that	you	want	to	import.	Boundary	Warp	in	action;	adjusting	the	slider	from	0	(above)	to	100	(below)	You
can	use	Boundary	Warp	together	with	the	Auto	Crop	setting.	Auto	white	balance	lock.	For	details,	see	Apply	adjustments.	See	these	resources:	Supported	camera	models	Supported	lens	profiles	Issues	fixed	in	this	release	of	Lightroom	Lightroom	for	mobile	|	iOS	2.6	|	December	2016	This	release	of	Lightroom	for	mobile	iOS	rolls	out	the	following	new
features	and	improvements	for	iPhone	and	iPad.	Now,	you	can	go	to	the	Adobe	Stock	Contributor	portal	to	tag	the	uploaded	images	and	submit	them	to	Adobe	Stock	for	moderation.	Set	White	Balance​Ã	ÂR.	The	resulting	raw	HDR	file	is	similar	to	the	type	of	file	you	would	get	when	using	the	HDR	merge	functionality	within	Lightroom	CC	on	your
desktop.	For	details,	see	Apply	local	adjustments	to	linear	or	radial	gradients.	Direct	control	to	adjust	Noise	Reduction	and	Enhanced	in	this	version	of	Lightroom	for	mobile	(iOS)	When	editing	your	photo	in	the	Magnifying	View	>	Edit	pane,	you	can	now	swipe	up	on	the	screen	to	display	the	Light,	Color,	and	Effects	menu	controls.	(iPad)	In	the	Edit
pane	menu	in	the	Magnifying	Glass	view,	tap	Accordion	Details.	Add	the	new	Camera	Lightroom	widget	to	directly	access	the	camera	in	the	app.	Support	for	new	cameras	and	lenses	Enhanced	in	this	version	of	Lightroom	for	mobile	iOS	For	a	complete	list	of	supported	cameras	and	lens	profiles,	see	these	resources:	Supported	Camera	Models
Supported	Lens	Profiles	Solved	an	issue	that	some	users	were	experiencing	when	importing	images.	Reduce	the	amount	of	mist	or	mist	in	a	photo.	To	set	this	preference:	Choose	Edit	>	Preferences.	Selected	photos	F.	Capture	interface	options.	Specify	Lightroom	mobile	sync	location	Enhanced	in	this	version	of	Lightroom	In	the	Lightroom	mobile
preferences	tab,	you	can	now	choose	a	preferred	location	on	the	Lightroom	desktop	to	sync	photos	with	Lightroom	for	mobile	and	also	specify	a	subfolders	structure	formatted	by	capture	date	of	image.	(Android)	Support	for	capturing	high-contrast	scenes	in	HDR	mode	is	already	available	on:	Samsung	S8,	Samsung	S8+,	Samsung	S7,	Samsung	S7
Edge,	Google	Pixel	and	Google	Pixel	XL	mobile	devices	only.	You	can	see	a	quick	preview	of	the	panorama	and	make	adjustments	to	it	before	the	merged	image	is	generated.	Get	instant	access	to	the	camera	in	the	Adobe	app	by	enabling	the	Lightroom	widget	for	Mobile	Notification	Center.	Read	on	for	a	quick	introduction	to	these	resources	and	links
to	resources	that	offer	more	information.	Importing	photos	from	Camera	Roll	or	Gallery	in	Time	view	mode.	Capture	settingsN.	Direct	controls	to	adjust	noise	reduction	and	in	your	photos.	Adjustment	of	the	corresponding	camera	profiles	applied	to	the	appearance	of	the	JPG	files	generated	by	the	camera.	Tapping	the	Lightroom	Camera	widget
launches	the	Lightroom	app	and	takes	it	directly	to	the	camera	function	the	application.	​	Fixed	an	issue	that	caused	a	crash	for	some	users	in	cutaway	mode.	Automatically	creates	µ	views	on	monitor	resolution.	For	more	details,	see	Edit	photos.	You	cannot	apply	this	run	manually.	(Left)	Auto	mode;	(A		µ	right)	Pro	A	mode.	For	optimal	performance,
many	development	³	operations	can	now	make	use	of	the	GPU.	Now,	you	cannot	move	the	Pen	in	S	to	the	left	or	right	through	the	device	screen	to	adjust	the	selected	hue.	You	cannot	add,	reorder,	or	remove	tracks	in	the	Music	panel.	Improvements	in	crops:	Cut	the	perfect	photo	with	a	redesigned	experience	that	lets	you	adjust,	align	and	straighten
automatically	quickly.	Here	are	the	features:	Supported	Camera	Models	Supported	Lens	Profiles	µ	fixed	in	this	version	of	Lightroom	for	mobile	(iOS)	2.7	and	Lightroom	for	mobile	(Android)	2.3	versions	µ	new	features	and	improvements	in	the	user	interface.	Here	are	some	examples:	Match	the	appearance	of	a	photo	for	predefined	creation.	Mobile
Lightroom	|	Android	3.0	|	July	2017	This	Lightroom	for	mobile	(Android)	release	implements	a	new	user	interface,	support	for	new	cameras	and	lenses	and	general	stability	improvements.	In	the	Preferences	dialog,	select	the	Performance	tab.	By	default,	all	photos	in	the	source	folder	are	imported.	Support	for	touch-enabled	computers​	The	new	one	in
this	version	of	Lightroom	Lightroom	now	offers	a	touch-enabled	workspace	experience.	This	overlay	allows	you	to	not	detect	the	overexposed	Areas	before	capturing	the	shot	and	adjusting	the	display	or	composition	Show	Highlight	Crop	in	the	Live	Capture	Scene	(Lightroom	for	iOS	³M	on	iPhone7	Plus)	Direct	Controls	for	Reducing	Rod	and
Sharpness​	New	in	this	version	of	Lightroom	for	Mobile	(iOS)	for	mobile	(iOS)	now	features	direct	controls	to	sharpen	your	photo	and	bring	details	in	them.	Lightroom	lets	you	preview	the	merged	file	and	adjust	the	thawing	amount	before	adding	it	as	a	DNG	file	to	your	cat.	New	New	Neither	Wenâ	ã	ã	.tsil	Drowyek	Eht	Sa	Yaw	Emas	Eht	Hcumâ	ã
Emsil	Noitcelloc	Eht	Retlif	Nac	Uoy	Won	.NoItcuder	Tsohg	DNA	Ytilauq	RDH	DevorPMI	.Tadetem	DNA	Sdrowyek	DDA,	Yllanoitpo	.CNERERERP	GNILACS	IU	SWODNIW	EHT	NO	NITPO%	052	Wen	Snoitcerroc	Lacol	DNA	STESERP	DETERC-RUOY	SSECCA	SWEIV	DIR	DNA	EPUOL	EHT	NI	TUO	/	NI	MOOZ	SGALF	DDA	SPIRTSMLIF	DNA	SLENAP
HGUORHT	LLORCS:	ECAPSKROW	HCUOT	EHT	NI	GNIWOLLOF	EHT	OD	OD	UOY,	SGNIHT	REHTO	GNOMA	.SLIATED	ROF)	YLNO	SOI	(LLOR	AREMAC	MORF	SOTOHP	SSECCA	YLTCERID	EES	.OTOHP	Ruoy	OT	THGIRYPOC	DNA,	NoInpac,	eltit	in	DDA	YLISAE	OT	UOY	SWOLLA	WEIV	EPUOL	EHT	NI	LENAP	OFNI	WEN	EHT)	YLNO	ENOHPI	(SOI
Elibom	ROF	MoThgil	Fo	Esainer	Siht	Ni	Wenâ	Ã,	.Weiv	Sredlof	Ecived	or	Yrellag	Ro	Aremac	MORF	SOTOHP	GITROPMI	.OTOHP)	ELBATIDE	(EVITO	NA	OT	TXEN	OTOHP)	Cited	(ECNERERFER	A	ECALP	UOY	STEL	HIKW	WEIV	PU-2	Detacided	to	SEDIVORP	ELUDOM	POLEVED	EHT	NI	Weiv	ECNERERER	SREBMEM	DUOLLC	DUOLC	DUOLC
EVITAERC	ROF	YLNO	ELBALIAVA	MOTHGIL	FO	ESAELER	SIHT	NI	WENÂ	Á,	Eludom	polved	e	HT	NI	Weiv	ECNERERERER	NI	KROW	8.6	MOTORHGIL	/	8.5102	CC	MoRTHGIL	.ELIFORP	SNEL	DNA	SAREMAC	WEN	ROF	TUOPUS	TUO	SLLOR	9.6	MOTORHGIL	/	9.5102	CC	MoRTHGIL	MOTHGIL	FO	ESAELER	SIHT	NI	DECNAHNE	SESNEL	DNA
SAREMAC	WEN	ROF	TROPPUS	9.6	MOTORHGIL	/	9.5102	CC	MoRTHGIL	.FÂ	Á,	Snoitpo	Yalrevo	Rednifweiv	.nwod	Epiws	Elgnis	at	Htiw	Aremac	PPA-NI	EHT	HCNual	Yllacitamotua	.eserp	Nor	GNitts	Redils	Ezahed	Eht	CNys-Otua	OT	ESOOOHC	RO,	Evas,	CNys,	YPOC	NAC	UOY	.Rab	NOITACIBITON	DIORDNA	RUOY	or	SUSTATS	DNA	SSERGORP
EHT	Tuoba	Noitacifiton	Trophy	Syalpsid	Won)	Dorordna	(Elibom	Rof	Moorthgil,	Shergorp	nor	if	Tropmi	na	Elihw	Snoitacifiton	Trophy	.neercs	Eht	Fo	Fo	Flah-Thgir	Nor	Drawnwod	Ro	Drawpu	Kcilf,	Lenap	Weiver	&	Etar	Eht	and	ETAR	EHT	or	Deggalfnu	RO,	Detcejer,	KCIP	SA	OTOHP	in	Galf	YLKCIUQ	OT	OTOHP	A	GALF	.SOTOHP	RUOY	GALF	DNA
ETAR	YLKCIUQ	OT	NoITCELLOC	Ruoy	HGuoorht	ELCYC)	SOI	(Elibom	ROF	MoRTHGIL	FO	ESAELER	SIHT	NI	DECNAHNE	LENAP	WEIVER	DNA	ETAR	EHT	or	SERUTSEG	GNIGGALF	DNA	Launching	Lightroom	for	Mobile	Devices	(Android)	The	local	adjustment	controls	in	the	Magnifying	Glass	view	allow	you	to	make	corrections	to	a	specific	area	of
a	photo.	Support	for	new	cameras	and	lenses	Enhanced	in	this	version	of	Lightroom	for	iOS	mobile	(iPhone	and	iPad)	For	a	complete	list	of	supported	cameras	and	lens	profiles,	see	these	resources:	Supported	camera	models	Supported	lens	profiles	Bug	fixes	and	performance	improvements.	Consider	upgrading	to	the	Creative	Cloud	Photography	plan
to	get	the	latest	updates	to	Lightroom	Classic	CC	and	Lightroom	CC	and	make	sure	the	software	works	with	raw	files	from	the	latest	cameras.	The	new	interface	makes	it	even	easier	to	capture	photos	at	their	best,	providing	a	modern	mobile	capture	experience.	Bug	fixes	and	performance	improvements.	Tap	the	icon	()	in	the	bottom	right	corner	to
block	the	automatic	exposure	of	the	camera	in	the	app	to	your	current	setting.	To	make	local	corrections,	you	can	apply	adjustments	using	the	Radial	Selection	tool	and	the	Linear	Selection	tool.	In	Lightroom	on	mobile	(iOS),	you	can	now	directly	access	the	photos	in	the	Camera	Roll	of	your	device	in	the	Collections	view	and	in	the	Lightroom	photo
view.	Bug	fixes	and	performance	improvements	Free	Lightroom.	|	Android	2.2	|	November	2016	Import	photos	from	a	connected	camera	with	PTP	support	New	in	this	version	of	Lightroom	for	mobile	devices	(Android)	Starting	with	this	version,	the	Lightroom	app	for	mobile	devices	(Android)	now	supports	the	image	transfer	protocol	(PTP).	|	Android
2.1.2	|	October	2016	Support	for	Samsung	S	Pen	New	in	this	version	of	Lightroom	for	mobile	devices	(Android)	Starting	with	this	version,	the	Lightroom	app	for	mobile	devices	(Android)	now	supports	the	use	of	the	S	Pen	on	compatible	Samsung	devices.	The	new	Auto	option	mu	mu	odnasu	revitse	ªÃcov	es	odalcet	ed	sohlata	arap	etropuS	moorthgiL
od	soir¡Ãusu	so	sodot	arap	lev​ÃnopsiD	.ratroceR	leniap	on	lacitreV	lev​ÃN	o£Ã§Ãpo		Ã	etnahlemes	etsuja	mu	euqilpa	ªÃcov	euq	etimrep	ratroceR	atnemarref		Ã	.arem¢ÃC	.ovitacilpa	on	arem¢Ãc	adarohlem	e	avon	amu	iussop	)diordnA(	eliboM	rof	moorthgiL	od	otnema§Ãnal	etnecer	siam	A	1.2	diordnA	|	ralulec	arap	moorthgiL	aremaC	ebodA	ad	WAR
o£Ãsrev	amitlºÃ	a	arap	etropus	sehl-atropmi	ªÃcov	odnauq	sotof	s	Ã	siarotua	sotierid	ed	seµÃ§Ãamrofni	saus	enoicidA	odalceT
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